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Introduction  
 
 

You will gain the most from this guide by first reviewing it. Also, be sure 
to backup your data. 

 
Data integration between BillQuick® (by BQE Software, Inc.) and Microsoft Office Accounting® (by 
Microsoft Corporation) can make your time billing, accounting and financial management tasks easier. 
Full-featured, BillQuick Time and Billing helps you manage your company, whether your time, expense, 
billing and reporting needs are simple or you demand complex billing, reporting and management 
capabilities. Microsoft Office Accounting is the complete accounting solution for Microsoft Office users 
for managing cash flow, payroll, taxes, invoicing and expenses. A typical BillQuick user does time and 
expense tracking, invoicing and payment entry in BillQuick. Since BillQuick integrates seamlessly with MS 
Office Accounting, you will still be able to perform your accounting and other financial tasks in MS Office 
Accounting, without having to enter your data twice. Integrated, BillQuick and Office Accounting deliver 
a virtual application that ensures data accuracy, eliminates time-consuming duplicate manual entry, enhances 
flexibility, and increases control over your bottom line.  
 
The goal of the BillQuickªMicrosoft Office Accounting Integration  Guide is to help new users 
effectively integrate data between BillQuick and Microsoft Office Accounting. BillQuick controls 
integration, enabling you to choose what data flows between the applications, and much more. The 
integration is complete, automated and configurable.  
 

Microsoft Office Accounting is the enhanced and improved version of 
Microsoft Small Business Accounting.  

 
 

How to  Use This Guide 
 
Integration means data from one application transfers to another. This sharing offers many benefits. You 
control what data transfers to and from BillQuick using synchronization settings. Your preferences tell 
BillQuick exactly how you want it to interact with MS Office Accounting. BillQuick automatically creates 
smart connections using your settings and built-in intelligence. When data is entered, modified or deleted 
in one program, it happens in the other immediately - in real-time. This can make your accounting and 
financial management tasks easier. 
 
We encourage you to review How Integration Works . Written for the non-technical user, it explains 
the integration rules built into BillQuick. Understanding what type of data may be shared and the rules 
applied during synchronization, will help you visualize what is happening behind the scenes.  
 
In Initial Integration Scenarios , you can choose the scenario that best fits your company. Instructions 
guide you through initial integration, whether you are a new/existing BillQuick or Office Accounting user. 
 
When you reach the point where data is checked to make sure everything is synchronized, Quick-Check 
provides specific guidance. Day-to-Day Integration Settings  provides suggestions for fine-tuning 
synchronization settings for normal, day-to-day processing.  
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Software  Editions Supported  
 
All BillQuick editions ð Basic, Pro (Microsoft Access database) and BillQuick Enterprise (MSDE, SQL 
Express and Microsoft SQL database) ð integrate with the following Microsoft Office Accounting editions: 
 
¶ Microsoft Office Accounting (2007 or later) 
¶ Microsoft Office Accounting Express (2005 or later) 
¶ Microsoft® Office Accounting Professional (2005 or later) 
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How Integration Works  
 
 
Even if you are not a technical person, it is helpful to understand the basics of BillQuickª MS Office 
Accounting integration. This can help you visualize what is happening behind the scenes as BillQuick 
manages transfer of information to and from MS Office Accounting. 
 
Each record common to BillQuick and MS Office Accounting share a unique Link ID that identifies them 
as related. This does not mean data in both records is exactly the same; only that they share common 
data. BillQuick Project records contain data and options that MS Office Accounting Job records do not 
and vice versa. What is important for integration is that the two applications share key data.  

 
Before integrating, backup your data in MS Office Accounting and 
BillQuick. 

 
The table below shows the direction in which data can potentially flow between BillQuick and MS Office 
Accounting. Whether it flows in one direction or the other depends on your choices on the BillQuick-MS 
Office Accounting Sync Settings screen. You can be very specific how data flows and to which accounts in 
MS Office Accounting. 
 

BillQuick  
Table Name 

Dataflow  MSOA  
Table Name 

Activity  D Service Item 

Expense D Non-Inventory Item 

Employee D Employee 

Vendor D Vendor 

Client D Customer 

Project D Job 

Expense Log D Expense/Bill  

Time Entry D Time Entry 

Invoice D Invoice  

Payment D Payment 

 
To review detailed, field-by-field mapping of records between MS Office 
Accounting and BillQuick, see BillQuick Help, BillQuick-MS Office 

Accounting Integration, Table & Field Mapping. 
 
As you can see above, BillQuickõs integration with MS Office Accounting is very comprehensive. Not only 
are invoices sent to MS Office Accounting, the virtual database for the two applications includes clients, 
projects/jobs, employees, vendors, activity codes, etc.  
 
Bottom Line: BillQuickª MS Office Accounting Integration is a feature that allows you to transfer or 
synchronize data between BillQuick and MS Office Accounting and delivers real-time synchronization 
between the two.  
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Integration Rules  
 
To ensure accuracy and completeness of data transfer, BillQuickªMS Office Accounting integration 
follows a set of rules. These are: 
 

1. Company Start Date Rule:  The start date of the MS Office Accounting Company is 
important as it cannot be changed later. MS Office Accounting does not transfer any 
invoices or payments from BillQuick if the date of the invoice or payment is older than its 
Company start date. Thus, when you are an existing BillQuick User integrating with MS 
Office Accounting for the first time, or you are new to both BillQuick and MS Office 
Accounting and manually entering invoices, payments, and/or time and expenses from a 
prior fiscal year, be sure to check the start date of the MS Office Accounting Company.  

2. Date Rule: When data is transferred from MS Office Accounting to BillQuick, the 
system date is converted to Greenwich Mean Time (GMT) and is recorded in the Last 
Updated field for each record. 

3. LinkID Rule:  BillQuick automatically creates an internal OfficeAccountingLinkID and 
adds it to the database. Used for internal processing, the special ID ensures accurate and 
complete transfer of data. 

4. Synchronization Order Rule:  When you send or get data on-demand from BillQuick 
or MS Office Accounting (via Send, Get or Sync menus), follow the order of the sub-
menus. For example, you should synchronize Clients before Projects and Invoices before 
Payments. 

5. Placeholder Data Rule: When BillQuick requires a data field that does not exist in MS 
Office Accounting, BillQuick inserts ôFromMSOfficeAccountingõ as a placeholder value 
during the data transfer. BillQuick automatically creates projects for invoices transferred 
from MS Office Accounting, if they donõt have jobs/projects associated with them. 

6. Bill Rate, Cost Rate Rule: While getting employee/vendor data from MS Office 
Accounting, BillQuick sets a default Bill Rate and Cost Rate of $1 for all the transferred 
records. You can change the rates in the Employee/Vendor screen in BillQuick. 

7. Client  Transfer Rule: BillQuick now transfers actual Client Names and Job Names 
(project) instead of numerical IDs from MS Office Accounting. Client contacts from 
BillQuick transfer to MS Office Accounting automatically when you synchronize clients. 

8. Time Entries: Microsoft Office Accounting does not support negative time entries, and 
hence these entries do not transfer from BillQuick during synchronization. 

9. Expense Rule: BillQuick sends expense entries directly to MS Office Accounting as a 
Vendor Bill from the Expense Log screen. You can get all expenses from Office 
Accounting into BillQuick database. 

10. Invoice Record Rule: Once an invoice is synchronized, it cannot be moved or 
synchronized again. Moreover, invoices (processed and draft) can be sent from BillQuick 
to MS Office Accounting but BillQuick does not receive pending invoices from MS Office 
Accounting. 

11. Payments Transfer Rule:  

¶ Payments from MS Office Accounting are transferred to BillQuick even if the 
associated invoices do not exist in BillQuick. These payments are regarded as 
retainers. Similarly, payments from BillQuick to MS Office Accounting transfer 
even if the invoices do not exist in Office Accounting.  
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¶ Retainer payments made directly to a client in MS Office Accounting are not sent 
to BillQuick. BillQuick transfers clientõs unused payments (Credits) as Client 
Retainer. 
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 Integration Wizard  
 
 

If you are new to BillQuick and MS Office Accounting, initial integration 
tasks will be completed after you have set up your information in one or 

the other application. 

 
Initial integration populates the BillQuick or MS Office Accounting firm database with information from 
the other application. Your initial synchronization settings define what information and how much of it is 
shared with the other application. For example, you may decide to move MS Office Accounting data for 
only the last two years to BillQuick.  
 
For initial integration setup, you can specify synchronization options on the BillQuickªMS Office 
Accounting Sync Settings and then use the menu to share each type of data with MS Office Accounting. 
You can do this by referring to the scenario best describing your needs, as discussed in Initial 
Integration Scenarios . 
 
Alternatively, you could make use of MS Office Accounting Integration Wizard in BillQuick, which is 
easier and faster tool for initial integration. This wizard walks you through the initial sync process, 
mapping of accounts and items, and finally the data transfer. 
 
 

MS Office Accounting  Integration Wizard  
 
The MS Office Accounting Integration Wizard is an easy to use tool for initial integration between 
BillQuick and MS Office Accounting. It walks you through the initial synchronization procedure and 
populates the BillQuick or Office Accounting database with available data. While the same task could be 
accomplished using the BillQuick-MS Office Accounting Sync Settings (refer to Initial Integration 
Scenarios), the wizard is an easier and faster tool for new users. By going through the items in the 
wizard, you can accomplish the initial synchronization easily.  
 
The steps involved in initial synchronization are: 
 
1. Start BillQuick, and open your company file. 

 
2. Access the Office Accounting Integration 

Wizard from the Accounting menu, Microsoft 
Office Accounting. 
 

3. The MS Office Accounting Integration 
Wizard opens. Click Next on the Welcome 
screen. 
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4. You will be prompted 
to choose a scenario 
that best describes your 
situation based on your 
usage of BillQuick and 
MS Office Accounting. 
 

5. The next screen 
displayed depends on 
what scenario you have 
chosen. In case of a 
New MS Office 
Accounting User, you 
need to create a new 
company file in MS 
Office Accounting. For 
users who have been 
using Office Accounting 
and/or BillQuick, you 
are prompted to backup 
your company database. Confirm that you made a backup copy of your Company database, and then 
click Next. 
 

6. You need to specify which Office Accounting Company file you want to use for the data sync. You 
can either let BillQuick automatically search for the last used Office Accounting Company file or 
manually select one. BillQuick will then connect to your Office Accounting database and access it. 
 

7. Office Accounting associates accounts to all the service, expense and invoice related items. Please 
select the Income Account, Expense Account and other accounts for invoice line items, invoice 
summary items and service/expense items sent to Office Accounting from BillQuick.  Select the 
appropriate default accounts from the available drop-down lists. 
 

8. Next, perform the Address, Phone and Fax Mapping. MS Office Accounting allows more than one 
type of address, phone and contact information. Hence, for accurate data sync between the two 
applications, specify the corresponding item in MS Office Accounting for BillQuick 
Employee/Customer/Vendor Address and Employee/Customer/ Vendor Phone/Fax fields. 
 

9. The wizard allows you to select modules of BillQuick that will sync with Office Accounting. In the 
next few screens, specify your sync settings for sending or getting data. You can Send or Get data 
to/from Office Accounting or skip the data sync for each module (Activity Codes, Expense Codes, 
Employee, Client, Vendor, Projects, Time Entry, Expenses, Invoices and Payments). 
 

10. Now you will be asked to choose the type of data integration. You can choose amongst: 
¶ On-Demand ð allows you to sync when you want to 
¶ On-Schedule ð allows you to schedule the synchronization process  
¶ Real-Time Synchronization ð allows you to have immediate, real-time sync  
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11. If you choose On-Schedule synchronization, you have to specify when you want to sync the data. You 
are provided with various Sync Options to choose from in the next panel. If you choose On-Demand 
sync, data sync process will start. 
 

12. To avoid data duplicity in case of existing users, the wizard attempts to find matching data and link 
them. This is done using the Smart Match feature of BillQuickªOffice Accounting Integration. If it 
fails to find a match, you will be able to match it manually. If you want to skip auto-match for certain 
tables, you need to uncheck the options provided. 
 

13. You may need to manually match the un-matched BillQuick and Office Accounting items. The Office 
Accounting items are displayed in the left list box while the BillQuick items are displayed in the right 
list box. Select the Office Accounting and BQ items from each list in the grid and click the Match 
Selected button. You can even view the matched data by clicking on the Show Matched button. Once 
done for all the un-matched items of various modules, click the Next button. 
 

14. Now, BillQuick is ready to sync with MS Office Accounting and a progress bar is displayed that shows 
the data transfer process. Your data synchronization process is thus completed! 
 

For future data sync, you can set the integration preferences using the 
BQ-MS OA Sync Settings screen. Read the next chapter for details. 
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Initial Integration Scenarios  
 
 
Preferences controlling how BillQuick and Microsoft Office Accounting work together are managed 
through the BillQuick-MS Office Accounting Sync Settings screen. BillQuick offers various integration 
options for new and regular users of integration function. BillQuick allows real-time, on-schedule and on-
demand synchronization. 
 
 

Security Permissions 
 
Before you ask BillQuick to synchronize data with MS Office Accounting, you must have security 
permission in BillQuick to perform the task. The BillQuick Supervisor in your company assigns integration 
(and other) rights to users. 
 
Also, you must direct Office Accounting to allow data communication with BillQuick.  As the owner of 
the Office Accounting database, you must give that permission, a process called Enabling Add-ins. 
 

1. Open the Microsoft Office Accounting application. 
 
2. Open the desired Office Accounting company file. 

 
3. Select File menu, Utilities, Add-In 

Manager. 
 

4. On the Office Accounting Add-in 
Manager screen, check ôEnabledõ 
option against BillQuick. This will 
add the BillQuick menus and 
toolbar to the MS Office 
Accounting application. 

 
5. Click OK and then restart the 

application to update the Office 
Accounting system with 
authorization.  

 
6. BillQuick is now on the Office 

Accounting toolbar. You can exit 
from Office Accounting now. 
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Scenario 1:  
Existing BillQuick -New Office Accounting  User 
 
BillQuick users who are new to Office Accounting start by transferring information from BillQuick to a 
new Office Accounting database. After creating the Office Accounting file and setting synchronization 
preferences, you initiate synchronization and verify the transferred data.  
 
Please follow the steps below to integrate BillQuick and Office Accounting. 
 

1. Office Accounting  Database 
 
Before integrating data with BillQuick, a new Office Accounting user must first create a new Office 
Accounting database and assign security permissions. See MS Office Accounting Help and other 
documentation for more details. 
 

1. Open MS Office 
Accounting and 
choose ôCreate 
New Companyõ 
option.  It will 
launch the Startup 
Wizard to help 
you set up a new 
company file. 

 
2. Add Company 

name and address 
details. 
 

3. Select your 
business type and 
let Office 
Accounting 
suggest accounts 
for it. 
 

4. Enter the Start Date of the first fiscal year and the company.  If you have transactions in 
BillQuick that are from previous years, make sure that you specify the earliest fiscal year 
to allow BillQuick to pass such transactions. 

 
This date is important because no data will transfer from BillQuick prior 
to the start date of the company as defined here. Office Accounting does 

not allow this date to be changed later. 

 
5. Select Jobs. All time and expenses must be billed to the job and not the client, even when there is 

only one job per client. 
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In BillQuick, an expense is treated like a product. Therefore, you need to 
choose both services and products to sync expenses. 

 
6. Enter the relevant information and click Finish to save. 

 

2.  Backup Database 
 
For the first-time sync, it is important to back up your BillQuick company database. Select BackUp 
Database from the Utilities menu. By default, BillQuick stores the backup copy in the same folder as the 
company database (for example, the standard installation folder x:\Program Files\BillQuick2009; x = 
drive letter). If you want the database copy to be saved in another location, select Global Settings-Misc 
screen from the Settings menu, and enter a new location.  
 

3.  Sync Settings 
 
For BillQuick to know what data to transfer and your other integration preferences, you need to define 
integration settings. Later, you can fine-tune the settings for day-to-day integration (see 5. Fine-Tune 
Synchronization Settings below).  
 

1. Look at the status at the bottom of the BillQuick screen. It displays the currently open BillQuick 
database. If it is not the one you want to integrate with the Office Accounting database, select File 
menu, Open Company. Choose the correct company and then continue to the next step. 
 

If data integration is initiated between BillQuick Sample database and 
Office Accounting database, you will be warned prior to the sync. 

 
2. From the BillQuick Accounting menu, select Microsoft Office Accounting, Sync Settings. 

 
3. The BillQuick-

MS Office 
Accounting Sync 
Settings screen 
displays. On the 
General tab, 
Browse to the 
desired Office 
Accounting 
database. 
 

4. Click ôConnectõ 
to establish a link 
with the Office 
Accounting 
Company file. 
Optionally, click 
ôAdd Menusõ 
button to add 
BillQuick to the Office Accounting menu.  
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5. When done, click Save to save these settings. 
 

6. Check whether the MS Office Accounting application is open to enable BillQuick to work with it 
(see Security Permissions above). 
 

7. Return to BillQuick, BillQuick-MS Office Accounting Sync Settings screen. 
 

8. Since, we want 
to transfer data 
from BillQuick 
to Office 
Accounting, click 
the Send Settings 
tab.  
 

9. On the left of 
the screen is the 
BillQuick Module 
list. Various 
filters and other 
sync options will 
be available 
based on which module is selected here. 

 

You only need to decide whether to send each type of BillQuick data to MS Office Accounting. If 
you wish to restrict what data records transfer to Office Accounting, choose one or more filters. 
See BillQuick Help for more information. 

 
The Get Settings tab is not used because we are sending data from 
BillQuick to populate a new Office Accounting database. 

 
10. Next, click on 

the Accounts 
tab. MS Office 
Accounting 
requires default 
accounts for 
every invoice 
line items, 
invoice summary 
items, service 
and expense 
items. Assign 
Office 
Accounting 
Income and 
Expense accounts for the BillQuick data (activity, expense, taxes, discounts, invoices, etc) to be 
transferred to Office Accounting. Click on the Save button and move on. 
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Income Account for Services/Expenses: On a BillQuick invoice, time and expense details are 
preserved but sent to Office Accounting as a lump sumñone entry for all the service items 
(activities) and one entry for all the expense items on an invoice. The Income and Expense 
accounts that are chosen here reflect invoice amounts sent from BillQuick. The corresponding 
accounts in Office Accounting will show the transferred amounts on the Profit and Loss 
statement.  
 
Income Account for Service/Expense Line Item Tax:  If you charge tax on service or 
expenses, the specified accounts will reflect the tax amounts. When you transfer invoices with 
taxes on them, the tax amounts show up on the P&L under the accounts shown here. 
 
Income Account for Main Service/Expense Tax:  These accounts refer to the amounts 
charged under the Main Service Tax (MST) and Main Expense Tax (MET) in BillQuick. The 
accounts chosen here will reflect MST and MET respectively in the P&L accounts in Office 
Accounting. 
 
Account for Discounts: The account chosen here will show in the Office Accounting P&L 
accounts. Discounts are applied to invoices in BillQuick in Billing Review and should have a 
corresponding account in Office Accounting for proper transfer. You can select any account 
Name/Type from the drop-down list. 
  
Income Account for Misc Amount:  This miscellaneous amount is for the lump sum of service 
items on manual invoices. Any item that is not marked as an expense in Manual Invoice transfers 
to Office Accounting as a miscellaneous amount and is reflected on the Profit and Loss report 
under the account assigned here. 
 
Income/Expense Account for Service/Expense Items: When activity and expense codes are 
transferred to Office Accounting, they are associated with the accounts selected here. The 
accounts chosen for these items will not impact the P&L account and are solely for the purpose 
of ensuring that there is an associated account with any expense code and activity code (service 
item) transferred to Office Accounting. E.g., for each Activity Code used in BillQuick, you have to 
specify the corresponding income account in Office Accounting. E.g. ôOther Incomeõ account can 
be selected but you can select any other account Name/Type from the drop-down list. 

 
11. Click on the Misc 

tab. In Office 
Accounting, 
multiple 
addresses and 
phone numbers 
are defined while 
as in BillQuick 
there is a single 
address for each 
employee, 
vendor and 
client.  
 
Select the 
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desired address fields in Office Accounting that you wish to link to corresponding BillQuick fields.  
 

12. Click the Save button to save all the sync settings and rules, and then exit. 
 

4.  Send Data 
 
Now you are ready to send data from BillQuick to Office Accounting. 
 

1. From the Accounting menu in 
BillQuick, select Microsoft 
Office Accounting, Send to 
Office Accounting.  

 
2. In turn, select each menu 

item, starting with Activity. 
After the progress bar 
indicates that the transfer is 
complete, open the 
corresponding screens in 
BillQuick and Office 
Accounting and verify 
whether the data is complete. 
See Quick Check for more 
information. 
 
Repeat this step for the next menu item. Below are the BillQuick Send menu items and the 
corresponding Office Accounting screen. 

 
BillQuick  

Send Menu Item  
MSOA 
Screen 

Activity * Service Item 

Expense Items* Non-Inventory Item 

Employees* Employee 

Vendor* Vendor 

Clients* Customer 

Projects* Job 

Expense Log* Expense  

Time Entry* Time Entry 

Invoices* Invoice  

Payments* Payment 

* The screen name may be different based on your profession or industry, or if you customized them using 
BillQuickõs Custom Label feature. 

 

5. Fine-Tune Synchronization Settings  
 
After you check the data transferred to Office Accounting, you may wish to change your integration 
settings to ones better suited to day-to-day synchronization. Please see Day-to-Day Integration Settings 
for more information. 
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Scenario 2:  
New BillQuick -Existing Office Accounting  User 
 
Office Accounting users who are new to BillQuick start by transferring information from Office 
Accounting to a new BillQuick database. After creating the BillQuick company file and setting 
synchronization preferences, you initiate synchronization and verify the transferred data.  
Please follow the steps below to integrate BillQuick and Office Accounting. 
 

1.  BillQuick Company  
 
Before integrating data, a new BillQuick user must first create a new BillQuick company database. 
BillQuick requires security permissions to perform this task. See BillQuick Help and other documentation 
for more details. 
 

1. In BillQuick, select File, New from the menu. Choose the type of database technology you wish 
to use. If unsure, choose Standard.  

 
The database technology available to you depends on the BillQuick 
Edition purchased. If you are unsure what edition you licensed, select 

About BillQuick from the Help menu. The edition abbreviation displays right 
after the version number. 

 

Edition  Database Technology 

BillQuick Basic Microsoft Access (Standard) 

BillQuick Pro 
Microsoft Access 
Microsoft SQL Desktop 
Engine 

BillQuick Enterprise 

Microsoft Access 
Microsoft SQL Desktop 
Engine 
Microsoft SQL Server 

 
2. On the New BillQuick Database dialog, enter a name for the new database. Most 

commonly, the company name is used for easy identification. Click the Open button. 
BillQuick creates the database and opens the BillQuick Start-Up Interview wizard. 

 
The BillQuick Start-Up Interview can be closed and reopened later. To 
do so, select Wizard, BillQuick Interview from the View menu. 

 
3. On the BillQuick Start-Up Interview panel, click the Next button.  
 
4. Leave Business Type blank. If you select a type, BillQuick copies industry-specific activity 

(service) and expense codes into your company database. These codes are not needed 
because items will transfer from Office Accounting into BillQuick. Click the Next button.  

 
5. Custom Labels allow you to customize key business terms to your profession and firm-

preferred terminology in BillQuick. Customizing terms eases transition from your old 
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time & billing solution. Select your preferred terms from the drop-down lists. When 
done, click the Next button. 

 
6. On the Company 

Name panel, 
enter your 
company name. 
Spell it exactly as 
it appears on 
your License & 
Registration or 
Evaluation Key 
document or 
email received.  

 
7. Click the Next 

button to accept 
the defaults on 
the remainder of 
the panels. You 
can update these 
options later on the Global Settings and User Preferences screens. On the last panel, 
click the Finish button 

 
8. The BillQuick 

Initial Setup 
Checklist wizard 
displays. This 
wizard enables 
the first time 
user to create 
master 
information; 
setting up basic 
employee, client, 
project, etc, 
confirming the 
actions using the 
checklists. When 
done, click the 
Close button. 

 
9. Next, the 

Company screen 
displays. Either complete the fields now and click the Save button when done. Or click 
the Close button and perform this task later. 
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10. From the File menu, select Login. For User 
ID, type ôsupervisorõ (without quotes), then 
for password, type ôsupervisorõ (without 
quotes). This gives you full security 
permissions in BillQuick to perform 
integration tasks. 

 
 
 

2.  Backup Database 
 
For the first-time sync, it is important to back up your Office Accounting database. Select Backup option 
from the File menu, Utilities, Data Utilities. Also, in Office Accounting you need to enable BillQuick to 
access its data (see Security Permissions above). 
 

3. Sync Settings 
 
For BillQuick to know what data to transfer and your other integration preferences, you need to define 
integration settings. Later, you can fine-tune the settings for day-to-day integration (see 5. Fine-Tune 
Synchronization Settings below). 
 

1. Look at the status line at the bottom of the BillQuick screen. It displays the currently open 
BillQuick database. If it is not the one you want to integrate with the Office Accounting database, 
select File menu, Open Company. Choose the correct company and then continue to the next 
step. 

 
2. From the BillQuick Accounting menu, 

select Microsoft Office Accounting, 
Sync Settings. 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 
 


